Guide Calc

Chapitre 3
Créer des diagrammes et des graphiques
Présenter des informations visuellement
Copyright

Ce document est Copyright © 2010–2013 par ses contributeurs tels que listés ci-dessous. Vous pouvez le distribuer et/ou le modifier sous les termes des licences GNU General Public License (http://www.gnu.org/licenses/gpl.html), version 3 ou ultérieure ou Creative Commons Attribution License (http://creativecommons.org/licenses/by/3.0/), version 3.0 ou ultérieure. Tous les noms de marque à l'intérieur de ce guide appartiennent à leur propriétaire légitime.

Contributeurs

Auteur : Christian Chenal
Relecteurs : François Bégasse, Philippe Clément

Retours

Veuillez envoyer vos commentaires ou suggestions à propos de ce document à :

doc@fr.libreoffice.org

Remerciements

Ce chapitre est basé sur les Chapitres 3 de OpenOffice.org 3.3 Calc Guide (anglais), LibreOffice 4.1 Calc Guide (anglais) et LibreOffice 4.0 Guide Calc (français). Les contributeurs à ces chapitres sont :

Richard Barnes  John Kane  Peter Kupfer  Sowbhagya Sundaresan
Shelagh Manton  Alexandre Martins  Anthony Petrillo  Jean Hollis Weber
Ingrid Halama  Linda Worthington  Barbara Duprey  Hal Parker
Christian Chenal  Philippe Clément  Pierre-Yves Samyn  Laurent Balland-Poirier
Peter Schofield  John A Smith

Date de publication et version du logiciel


Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d'exploitation Windows, Linux et Mac OS X, chacun de ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner lieu à des options d'affichage différentes (polices, couleurs, thèmes, gestionnaire de fenêtres, icônes). De plus, ces options d'affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations de ce chapitre ont été réalisées sous Windows avec le jeu d'icônes Galaxy. Certaines images ne ressembleront donc pas exactement à ce que vous voyez sur votre ordinateur. En cas de confusion sur une icône, dont l'apparence peut être très différente d'un jeu à l'autre, vous pouvez vérifier son nom, qui apparaît dans l'infobulle lorsque vous placez le pointeur de la souris au-dessus.
Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

<table>
<thead>
<tr>
<th>Windows/Linux</th>
<th>Équivalent Mac</th>
<th>Effet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sélection de menu</td>
<td>LibreOffice &gt; Préférences</td>
<td>Accès aux options de paramétrage</td>
</tr>
<tr>
<td>Outils &gt; Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clic droit</td>
<td>⌘ + clic</td>
<td>Ouvre un menu contextuel</td>
</tr>
<tr>
<td>Ctrl (Contrôle)</td>
<td>⌘ (Commande)</td>
<td>Utilisé avec d'autres touches</td>
</tr>
<tr>
<td>F5</td>
<td>Maj + ⌘ + F5</td>
<td>Ouvre le Navigateur</td>
</tr>
<tr>
<td>F11</td>
<td>⌘ + T</td>
<td>Ouvre la fenêtre Styles &amp; Formatage</td>
</tr>
</tbody>
</table>
Table des matières

Copyright........................................................................................................................................... 2
Apparence de LibreOffice....................................................................................................................... 2
Note pour les utilisateurs Mac............................................................................................................. 3
Introduction........................................................................................................................................... 6
Créer un diagramme avec l'Assistant.................................................................................................... 6
  Créer le diagramme.......................................................................................................................... 6
  Choisir le type de diagramme........................................................................................................... 8
  Modifier les plages de données et les étiquettes des axes................................................................ 8
  Sélectionner les séries de données.................................................................................................. 9
  Ajouter ou modifier les titres, les légendes et les grilles................................................................. 10
Modifier les diagrammes..................................................................................................................... 10
  Changer le type de diagramme........................................................................................................ 11
  Ajouter ou supprimer des éléments du diagramme........................................................................ 11
  Étiquettes des données.................................................................................................................... 12
  Courbes de tendance....................................................................................................................... 14
  Courbes de valeur moyenne........................................................................................................... 15
  Barres d'erreur X ou Y..................................................................................................................... 15
Formatter les diagrammes.................................................................................................................. 16
  Déplacer les éléments du diagramme............................................................................................. 17
  Changer l'arrière-plan de la zone du diagramme.......................................................................... 18
  Changer l'arrière-plan de la paroi du diagramme........................................................................... 18
  Changer les couleurs....................................................................................................................... 18
Formatter les diagrammes 3D............................................................................................................ 19
  Rotation et perspective.................................................................................................................... 19
  Apparence....................................................................................................................................... 19
  Éclairage.......................................................................................................................................... 20
  Faire tourner les diagrammes 3D de manière interactive............................................................... 21
Formatter les éléments du diagramme............................................................................................... 21
  Formater les grilles........................................................................................................................ 21
  Formater les axes............................................................................................................................ 22
    Onglet Échelle.............................................................................................................................. 22
    Onglet Positionnement.................................................................................................................. 24
    Onglet Étiquette............................................................................................................................ 25
    Onglets Ligne, Nombres, Police et Effets de caractère.............................................................. 25
  Étiquettes d'axes hiérarchiques......................................................................................................... 26
  Choisir et formater les symboles...................................................................................................... 26
Ajouter des objets dessinés aux diagrammes....................................................................................... 27
Redimensionner et déplacer le diagramme.......................................................................................... 27
  Utiliser la souris............................................................................................................................ 27
  Utiliser la boîte de dialogue Position et taille.............................................................................. 28
Exporter un diagramme en tant qu'image............................................................................................ 29
Format OpenDocument ODC.............................................................................................................. 29
Enregistrer un diagramme au format ODC ................................................................. 29
Ouvrir un diagramme au format ODC ........................................................................ 29
Insérer un diagramme ODC dans un classeur ............................................................ 29

Galerie des types de diagramme .................................................................................. 29
Colonne ...................................................................................................................... 30
Barre .......................................................................................................................... 30
Secteur ....................................................................................................................... 31
Zone ............................................................................................................................. 33
Ligne ........................................................................................................................... 34
Dispersion ou XY ........................................................................................................ 35
Bulles .......................................................................................................................... 36
Toile ............................................................................................................................ 37
Cours ........................................................................................................................... 39
Colonne et ligne ......................................................................................................... 40
Introduction

Les diagrammes et les graphiques sont souvent des moyens puissants de transmettre de l'information au lecteur. LibreOffice Calc propose une variété de formats de diagrammes et de graphiques pour vos données.

Avec Calc, vous pouvez personnaliser vos diagrammes et vos graphiques de manière très poussée. Toutes ces options vous permettent de présenter vos informations de la manière la meilleure et la plus claire.

Créer un diagramme avec l'Assistant

Calc utilise l'Assistant de diagramme pour créer des diagrammes dans vos classeurs. Une fois le diagramme créé en tant qu'objet dans votre classeur, vous pouvez alors changer le type de diagramme, modifier les plages de données et éditer le diagramme avec cet Assistant. Chaque changement que vous effectuez est automatiquement reporté dans l'objet diagramme.

Pour faire la démonstration de la méthode pour réaliser des diagrammes et des graphiques dans Calc, nous allons utiliser la petite table de données de la Figure 1.

![Figure 1 : Table de données pour les exemples de diagrammes](image)

Créer le diagramme

Pour créer un diagramme, mettez tout d'abord en surbrillance (sélectionnez) les données à inclure dans le diagramme. Il n'est pas indispensable que la sélection soit une plage contiguë, comme dans la Figure 2 ; vous pouvez également choisir des cellules individuelles ou des groupes de cellules (colonnes ou lignes). Voir Chapitre 1 (Introduction à Calc) pour plus d'informations sur la sélection des cellules ou des plages de cellules.

Astuce

Avant de choisir l'Assistant de diagramme, placez le curseur n'importe où dans la zone de données. L'Assistant de diagramme discernera généralement correctement la plage de données. Faites juste attention à ne pas inclure le titre du tableau de données.
Ensuite, ouvrez la boîte de dialogue de l’Assistant de diagramme en choisissant **Insertion > Objet > Diagramme** dans la barre de menus ou en cliquant sur l’icône **Diagramme** dans la barre d’outils Standard.

Chaque méthode insère un diagramme par défaut dans la feuille, ouvre la barre d’outils Formatage dédiée et l’Assistant de diagramme, comme illustré Figure 3.
**Choisir le type de diagramme**

L'Assistant de diagramme comporte trois grandes parties : une liste d'étapes mises en œuvre pour paramétrer un diagramme, une liste de types de diagrammes et les options pour chaque type de diagramme. Vous pouvez à tout moment revenir à l'étape précédente et changer les sélections.

Calc propose un choix parmi dix types de diagrammes de base, avec quelques options pour chaque type. Ces options changent selon le type de diagramme que vous choisissez.

Les premiers éléments de choix sont les diagrammes à deux dimensions (2D). Seuls certains types où la 3D est applicable (Colonne, Barre, Secteur et Zone) vous donnent l'option de sélectionner un rendu 3D.

Dans la page *Choisissez un type de diagramme* (Figure 3), sélectionnez un type en cliquant sur son icône. L’aperçu se met à jour à chaque fois que vous sélectionnez un type de diagramme différent et fournit un rendu très fidèle du diagramme final.

La sélection courante est en surbrillance (affichée avec un contour) dans la page *Choisissez le type de diagramme*. Le nom du diagramme est affiché juste en dessous des icônes. Pour le moment, choisissez le diagramme Colonne et cliquez sur Suivant.

**Modifier les plages de données et les étiquettes des axes**

Dans l'étape 2, Plage de données, vous pouvez corriger manuellement toutes les erreurs éventuelles que vous avez commises en sélectionnant les données.

Vous pouvez éditer le champ *Plage de données* pour modifier les lignes et les colonnes qui constituent les données de votre diagramme. Si vous avez besoin de données qui se trouvent dans des cellules non contiguës, saisissez les différentes plages séparées par le délimiteur point-virgule. Par exemple, vous pouvez saisir $Feuille1.A1:A5;$Feuille1.D1:D5.

Vous pouvez également changer la façon dont vous tracez les données en utilisant les lignes, plutôt que les colonnes, comme séries de données. C’est utile si vous utilisez un style de diagramme comme Secteur pour afficher vos données.

Enfin, vous pouvez choisir d’utiliser la première ligne, la première colonne, ou les deux, comme étiquettes des axes du diagramme.

*Figure 4 : Modifier les plages de données et les étiquettes des axes*
Vous pouvez confirmer ce que vous avez fait jusque-là en cliquant sur le bouton **Terminer**, ou cliquer sur **Suivant** pour modifier plus de détails dans le diagramme.

Cliquez sur **Suivant** pour examiner l'ensemble des options disponibles à apporter au diagramme en utilisant les autres pages de l'Assistant.

** Sélectionner les séries de données **

Dans la page **Séries de données**, vous pouvez déterminer précisément les données que vous voulez inclure dans votre diagramme. Vous avez peut-être décidé que vous ne voulez pas inclure les données pour les canoës. Dans ce cas, mettez en surbrillance **Canoës** dans le champ **Séries de données** et cliquez sur **Supprimer**. Pour chaque série de données énumérée, sont spécifiées les plages de données pour son nom et ses valeurs Y. Ceci est utile si vous avez des besoins très particuliers pour les données de votre diagramme, et pour alors inclure ou omettre ces plages.

Vous pouvez ordonner les séries de données dans votre diagramme comme vous le souhaitez en sélectionnant une série de données et en utilisant les boutons des flèches ↑ et ↓.

**Figure 5 : Modifier les séries et les plages de données**

**Astuce**

Vous pouvez cliquer sur le bouton ** Sélectionner** à côté du champ **Plage pour Nom** pour travailler directement dans la feuille. C'est pratique si vos plages de données sont grandes ou masquées par l’Assistant.

Une autre façon de tracer des colonnes de données non adjacentes est de sélectionner la première série de données et de sélectionner ensuite les séries suivantes en gardant appuyée la touche **Ctrl**. Vous pouvez saisir également les colonnes dans les zones de texte. Les colonnes doivent être séparées par des points-virgules. Ainsi, pour tracer **B3:B11** avec **G3:G11**, saisissez la plage de sélection **B3:B11;G3:G11**.

Les deux séries de données que vous sélectionnez doivent être dans des colonnes ou des lignes séparées. Sinon Calc supposera que vous faites un ajout à une même série.

Cliquez sur **Suivant** pour gérer les titres, les légendes et les grilles.
Ajouter ou modifier les titres, les légendes et les grilles

Les différents éléments d'un diagramme sont illustrés dans "Ajouter ou supprimer des éléments du diagramme" page 11.

Dans la page Éléments du diagramme (Figure 6), vous pouvez donner à votre diagramme un titre et, si besoin est, un sous-titre. Utilisez un titre qui attire l'attention des lecteurs vers le propos du diagramme : ce que vous voulez qu'ils voient. Par exemple, un titre plus judicieux pour ce diagramme pourrait être Résultats des locations de bateaux et autres équipements nautiques au 1er semestre.

Il peut être intéressant d'avoir des étiquettes pour l'axe X ou l'axe Y. C'est l'endroit où vous donnez au lecteur une notion comme la proportion de vos données. Par exemple, si vous mettez Milliers dans l'étiquette de l'axe Y de votre graphique, cela change entièrement la signification de votre diagramme. Pour faciliter l'analyse des données, vous pouvez également afficher les grilles des axes X ou Y en cochant les options Afficher les grilles.

Vous pouvez omettre la légende, l'inclure, la placer à gauche, à droite, en haut ou en bas.

Pour confirmer vos sélections et terminer le diagramme, cliquez sur Terminer.

Figure 6 : Titres, légendes et grilles

Note
Le bouton Terminer ferme l'assistant, mais le diagramme reste en mode Édition dans lequel vous pouvez continuer de le modifier. Cliquez en dehors du diagramme, par exemple dans une cellule du tableau, pour terminer effectivement la création du graphique.

Modifier les diagrammes

Après avoir créé un diagramme, vous pourriez souhaiter le modifier. Calc fournit des outils pour changer le type de diagramme, les éléments, les plages de données, les polices, les couleurs et bien d'autres options, via les menus Insertion et Format, les menus contextuels (clic droit) et la barre d'outils Formatage dédiée.
Changer le type de diagramme
Vous pouvez changer le type de diagramme à tout moment. Pour ce faire :

1) Éditez tout d’abord le diagramme en le double-cliquant. Le diagramme devrait être maintenant entouré par une bordure grise.
2) Puis utilisez l’une des possibilités suivantes :
   • Choisissez Format > Type de diagramme dans la barre de menus.
   • Cliquez sur l’icône Type de diagramme dans la barre d’outils Formatage.
   • Faites un clic droit dans le diagramme et choisissez Type de diagramme.
   Dans chaque cas, une boîte de dialogue similaire à celle de la Figure 3 s’ouvre. Voir page 8 pour plus d’informations.
3) Sélectionnez le nouveau type de diagramme.
4) Cliquez sur OK.

Ajouter ou supprimer des éléments du diagramme
La Figure 7 et la Figure 8 montrent les éléments des diagrammes 2D et 3D.
Le diagramme 2D par défaut comprend seulement deux de ces éléments :
   • La paroi du diagramme contient le dessin du diagramme affichant les données.
   • La zone de diagramme est la zone entourée de gris autour du dessin du diagramme. Le titre du diagramme (optionnel) et la légende se trouvent dans cette zone.

![Figure 7 : Éléments d’un diagramme 2D](image)

Le diagramme 3D par défaut comporte aussi un plancher de diagramme, qui n’est pas actif dans les diagrammes 2D.

Modifier les diagrammes
Figure 8 : Éléments d'un diagramme 3D

Vous pouvez ajouter d'autres éléments en utilisant les commandes du menu Insertion. Les différentes options ouvrent des boîtes de dialogue dans lesquelles vous pouvez préciser les détails.

Les boîtes de dialogue pour les Titres, la Légende, les Axes et les Grilles sont suffisamment explicites. Les autres sont un peu plus compliquées, nous allons donc les examiner ci-dessous. Il est également possible d'ajouter des objets de dessin, comme expliqué page 27.

Étiquettes des données

Les étiquettes des données apportent de l'information pour chaque point de données dans le diagramme. Elles peuvent être très utiles pour présenter des informations détaillées, mais vous devez prendre garde à ne pas créer un diagramme trop confus.

Éditez le graphique comme décrit ci-dessus et choisissez Insertion > Étiquettes des données. Les options sont les suivantes :

**Afficher la valeur sous forme de nombre**

Affiche les valeurs numériques des points de données. Quand elle est cochée, cette option active le bouton Format de nombre.

**Format de nombre**

Ouvre une boîte de dialogue où vous pouvez choisir le format des nombres. L'option Source du format vous permet de conserver le format des nombres de la source des données. Décochez cette option pour accéder aux autres paramètres et définir un nouveau format. Cette boîte de dialogue est très similaire à celle utilisée pour formater les nombres des cellules, telle que décrite au Chapitre 2 (Entrer, modifier et formater des données).

**Afficher la valeur sous forme de pourcentage**

Affiche la valeur de pourcentage des points de données dans chaque colonne. Quand elle est cochée, cette option active le bouton Format de pourcentage.
Format de pourcentage
Ouvre la boîte de dialogue Format numérique pour valeur en pourcentage, où vous pouvez sélectionner le format du pourcentage. L'option Source du format vous permet de conserver le format des nombres de la source des données. Décochez cette option pour accéder aux autres paramètres et définir un nouveau format.

![Figure 9 : Boîte de dialogue Étiquettes de données](image)

Afficher la catégorie
Affiche les étiquettes de texte des points de données.

Afficher le symbole de légende
Affiche les icônes de légende près de chaque étiquette de point de données.

Séparateur
Sélectionne le séparateur entre les étiquettes (si au moins deux options ci-dessus ont été cochées).

Placement
Sélectionne l'emplacement des étiquettes de données par rapport aux objets.

Tourner le texte
Cliquez dans le panneau circulaire pour choisir l'angle de rotation des étiquettes de données, ou saisissez une valeur en degrés.

La Figure 24 page 32 montre des exemples de valeurs en texte (ni Afficher la valeur sous forme de nombre, ni Afficher la valeur sous forme de pourcentage ne sont cochées) et de valeurs en pourcentage, ainsi que des valeurs de données utilisées à la place de la légende ou en conjonction avec elle.

Note
Le texte des étiquettes de données provient des données du classeur et ne peut être modifié ici. Si vous avez besoin d'abréger des textes, ou les modifier plus profondément, vous devez le faire dans les plages de données que vous utilisez comme source du diagramme.
**Courbes de tendance**

Quand vous avez un ensemble de points dispersés dans un graphique, vous pouvez vouloir montrer la relation entre les points. Une courbe de tendance est ce dont vous avez besoin. Calc dispose d'une bonne sélection de types de régressions que vous pouvez utiliser pour les courbes de tendance : linéaire, logarithmique, exponentielle et puissance. Choisissez le type qui se rapproche le plus du passage entre tous les points.

Pour insérer des courbes de tendance pour toutes les séries de données, double-cliquez dans le diagramme pour entrer en mode édition. Choisissez **Insertion > Courbe de tendance**, puis cochez le type de courbe de tendance entre **Aucun**, **Linéaire**, **Logarithmique**, **Exponentielle** et **Puissance**. Vous pouvez également choisir d'afficher l'équation pour la courbe de tendance et le coefficient de détermination ($R^2$).

Pour insérer une courbe de tendance pour une seule série de données, sélectionnez d'abord la série de données dans le diagramme, puis choisissez **Insertion > Courbe de tendance**, ou faites un clic droit et choisissez **Insérer une courbe de tendance** dans le menu contextuel. La boîte de dialogue est identique à celle ci-dessous, mais a un second onglet (**Ligne**), où vous pouvez choisir les attributs (style, couleur, largeur et transparence) de la ligne.

![Figure 10 : Boîte de dialogue Courbes de tendance](image)

La courbe de tendance est automatiquement insérée dans la légende.

Pour supprimer une seule courbe de tendance ou une ligne de valeurs moyennes, cliquez sur la ligne et appuyez sur la touche **Suppr**, ou faites un clic droit sur la série de données puis choisissez **Supprimer la courbe de tendance**.

Pour supprimer toutes les courbes de tendance, choisissez **Insertion > Courbe de tendance**, puis cochez **Aucun**.

Si vous insérez une courbe de tendance dans un diagramme d'un type qui utilise des catégories, comme Ligne ou Colonne, alors les numéros 1, 2, 3, ... sont utilisés comme valeurs X pour calculer la courbe de tendance.

La courbe de tendance a la même couleur que la série de données correspondante. Pour modifier les propriétés de la ligne, sélectionnez la courbe de tendance et choisissez **Formatter la courbe de tendance**. La boîte de dialogue Courbe de tendance s'ouvre. Utilisez l'onglet **Ligne**.
Pour afficher l'équation de la courbe de tendance, sélectionnez la courbe de tendance dans le diagramme, faites un clic droit pour ouvrir le menu contextuel et choisissez **Insérer l'équation de la courbe de tendance**.

Quand le diagramme est en mode édition, LibreOffice vous donne l'équation de la courbe de tendance et le coefficient de corrélation. Cliquez sur la courbe de tendance pour voir l'information dans la barre d'état. Pour afficher l'équation et le coefficient de corrélation dans le graphique, sélectionnez la ligne et choisissez **Insérer R² et l'équation de la courbe de tendance**.

Pour plus de détails sur les équations de régression, voir l'article *Courbes de tendance dans les diagrammes* dans l'Aide.

**Courbes de valeur moyenne**

Si vous sélectionnez **Courbes de valeur moyenne** dans le menu **Insertion**, Calc calcule la moyenne de chaque série de données sélectionnée et place une ligne de couleur au niveau correct dans le diagramme.

**Barres d'erreur X ou Y**

Si vous présentez des données qui ont une possibilité connue d'erreur, comme un sondage de société utilisant une méthode d'échantillonnage particulière, ou si vous voulez montrer la précision mesurée de l'outil que vous avez utilisé, vous pouvez souhaiter afficher des barres d'erreur dans le diagramme. Éditez le diagramme et choisissez **Insertion > Barres d'erreur Y** ou **Insertion > Barres d'erreur X**. Ces options ne sont disponibles qu'avec certains types de diagramme.

Plusieurs options sont proposées dans la boîte de dialogue Barres d'erreur X ou Y. Vous ne pouvez choisir qu'une option à la fois. Vous pouvez également choisir si l'indicateur d'erreur affiche les erreurs positives et négatives, ou seulement positives, ou seulement négatives.

- **Valeur constante** : vous pouvez avoir des valeurs positives et négatives différentes.
- **Pourcentage** : choisissez l'erreur comme un pourcentage des points de données.
- Dans la liste déroulante :
  - **Erreur type** : calcule l'erreur selon les données numériques affichées dans le diagramme.
  - **Écart type** : montre l'erreur calculée selon l'écart type à partir du nombre de points de données et des valeurs respectives.
  - **Variance** : montre l'erreur calculée selon la variance à partir du nombre de points de données et des valeurs respectives.
  - **Marge d'erreur** : vous personnalisez l'erreur.
- **Plage de cellules** : calcule l'erreur selon la plage de cellules que vous sélectionnez. La section Paramètres en bas de la boîte de dialogue se modifie pour permettre la sélection de plages de cellules.
Formater les diagrammes

Le menu Format comporte plusieurs options pour formater et pour régler finement l'apparence de vos diagrammes.

Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise, ce qui indique qu'il est en mode édition ; puis sélectionnez l'élément de diagramme que vous voulez formater.

Choisissez Format dans la barre de menus, ou faites un clic droit pour afficher le menu contextuel propre à l'élément sélectionné. Les options de formatage sont les suivantes.

**Formater la sélection**
Ouvre une boîte de dialogue dans laquelle vous pouvez spécifier le remplissage, les bordures, la transparence, les caractéristiques des textes, les effets de police et d'autres attributs des éléments sélectionnés du diagramme (voir page 21).

**Position et taille**
Ouvre une boîte de dialogue (voir page 28). Ne s'applique qu'à certains éléments du diagramme.

**Disposition**
Offre un choix : Envoyer vers l'avant ou Envoyer vers l'arrière. Pour certains éléments, un seul choix peut être actif. Utilisez cette option pour gérer l'ordre des séries de données ou le recouvrement d'éléments.

**Titre**
Formate les titres du diagramme et de ses axes.

**Légende**
Formate l'emplacement, les bordures, l'arrière-plan et le type de la légende.

**Axe**
Formate les lignes qui créent le diagramme, ainsi que la police du texte qui apparaît sur les axes X et Y.

**Grille**
Formate les lignes qui créent une grille pour le diagramme.
Paroi du diagramme, Plancher du diagramme, Arrière-plan du diagramme
Ces fonctions sont décrites dans les sections suivantes.

Type de diagramme
Change le type de diagramme qui est affiché et s'il est à deux ou trois dimensions.

Plages de données
Expliquée page 8 (Figure 4 et Figure 5).

Affichage 3D
Formate les diagrammes 3D (voir page 19).

| Note | Plancher du diagramme et Affichage 3D sont seulement disponibles pour les diagrammes 3D. Ces options sont inactives (grisées) si un diagramme 2D est sélectionné. |

Dans la plupart des cas, vous aurez besoin de sélectionner l'élément exact que vous voulez formater. Parfois, il peut être délicat de le faire à l'aide de la souris, si le diagramme comporte beaucoup d'éléments, et particulièrement si certains d'entre eux sont petits ou se recouvrent. Utilisez dans ce cas la liste de sélection, le premier outil de la barre d'outils Formatage (Figure 3).

Si les Infobulles sont activées (dans Outils > Options > LibreOffice > Général, section Aide, sélectionnez Infobulles), et si alors vous déplacez la souris au-dessus de chaque élément, son nom apparaît dans l'Infobulle. Une fois que vous avez sélectionné un élément, vous pouvez appuyer sur Tab pour vous déplacer vers les autres éléments jusqu'à ce que vous trouviez celui que vous recherchez. Le nom de l'élément sélectionné apparaît dans la liste de sélection et dans la barre d'état.

Déplacer les éléments du diagramme
Vous pouvez souhaiter déplacer les éléments individuels d'un diagramme, indépendamment des autres éléments. Par exemple, vous pouvez souhaiter déplacer la légende à un autre endroit. Les diagrammes de type secteur permettent le déplacement individuel de chaque secteur (en plus du choix d'éclater tous les secteurs). En revanche, il n'est pas possible de déplacer individuellement un point ou une série de données.

Pour déplacer un élément, placez le curseur de la souris au-dessus de lui. Lorsque le curseur devient le symbole de déplacement 🔄, vous pouvez cliquer et faire glisser l'élément pour le déplacer.

| Note | Si votre diagramme est 3D, cliquer sur la paroi du diagramme fait apparaître des poignées rondes rouges pour contrôler l'aspect tridimensionnel du graphique. Vous ne pouvez pas redimensionner ou repositionner le graphique tant que ces poignées rouges apparaissent. Si les poignées rouges sont visibles, faites Maj+Clic pour obtenir les poignées vertes de redimensionnement. Vous pouvez alors redimensionner et repositionner votre graphique 3D. |
Changer l'arrière-plan de la zone du diagramme

La zone du diagramme est la zone qui entoure le graphique du diagramme, incluant le titre principal (optionnel) et la légende.

1) Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise.
2) Choisissez Format > Arrière-plan du diagramme ou faites un clic droit dans la zone du diagramme et choisissez Formater la zone du diagramme.
3) Dans la boîte de dialogue Zone du diagramme, choisissez les options voulues et cliquez sur OK.

Dans l'onglet Zone, vous pouvez changer la couleur ou choisir un motif de hachure, un bitmap ou des dégradés prédéfinis. Cliquez dans la liste déroulante pour voir les options.

Vous pouvez également utiliser l'onglet Transparency pour changer la transparence de la zone. Si vous utilisez un dégradé prédéfini dans l'onglet Zone, vous pouvez voir les différents paramètres qui le composent.

![Figure 12 : Boîte de dialogue Zone du diagramme](image)

Changer l'arrière-plan de la paroi du diagramme

La paroi du diagramme est la zone qui contient le graphique du diagramme (non disponible pour les types Secteurs et Toile).

1) Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise.
2) Choisissez Format > Paroi du diagramme ou faites un clic droit dans le diagramme et choisissez Formater la paroi. La boîte de dialogue Paroi du diagramme a les mêmes options de formatage que dans “Changer l'arrière-plan de la zone du diagramme” ci-dessus.
3) Choisissez vos paramètres et cliquez sur OK.

Changer les couleurs

Si vous avez besoin d'une palette de couleurs différente de celle par défaut dans tous vos documents, allez à Outils > Options > Diagrammes > Couleurs par défaut, où vous pourrez associer des couleurs aux séries de données. Les changements que vous ferez ici affecteront les couleurs par défaut de tous les diagrammes que vous ferez à l'avenir.

Formatter les diagrammes 18
**Formatter les diagrammes 3D**

Utilisez **Format > Affichage 3D** pour régler finement les diagrammes 3D. La boîte de dialogue Affichage 3D a trois onglets, où vous pouvez changer la perspective du diagramme, déterminer si le diagramme utilise des schémas simples ou réalistes ou vos propres schémas, et l'éclairage qui contrôle les ombres.

**Rotation et perspective**

Pour faire tourner un diagramme 3D ou le voir en perspective, saisissez les valeurs voulues dans l'onglet **Perspective** de la boîte de dialogue Affichage 3D. Vous pouvez également faire tourner les diagrammes 3D de manière interactive ; voir page 21.

![Figure 13 : Faire tourner un diagramme](image)

Voici quelques astuces pour utiliser l'onglet **Perspective** :

- Paramétrez tous les angles à 0 pour une vue frontale du diagramme. Les diagrammes de type secteur et tore sont affichés comme des cercles.
- Avec **Axes à angle droit** coché, vous ne pouvez faire tourner le contenu du diagramme que dans les directions X et Y ; c'est-à-dire, parallèlement aux bordures du diagramme.
- Une valeur X de 90, avec Y et Z mis à 0, fournit une vue depuis le dessus du diagramme. Avec X à –90, la vue est depuis le dessous du diagramme.
- Les rotations sont appliquées dans l'ordre suivant : X en premier, puis Y et enfin Z.
- Quand l'ombrage est actif et que vous faites tourner le diagramme, l'éclairage tourne comme s'il était fixé au diagramme.
- Les axes de rotation se réfèrent toujours à la page, et non aux axes du diagramme. C'est une différence par rapport à certains autres programmes de graphiques.
- Cochez l'option **Perspective** pour voir le diagramme dans une perspective centrale, comme à travers la lentille d'un objectif, au lieu d'une projection parallèle.

Fixez la longueur de focale dans le champ près de l'option **Perspective** (elle devient active quand vous cochez l'option). La valeur 100% donne une vue en perspective où le côté éloigné du diagramme paraît à peu près moitié moins que le côté proche.

**Apparence**

Utilisez l'onglet **Apparence** pour modifier certains aspects de l'apparence d'un diagramme 3D.
Sélectionnez un jeu dans la liste déroulante. Quand vous sélectionnez un jeu, les options et les sources d'éclairage sont paramétrées en fonction de vos désiderata. Si vous sélectionnez ou désélectionnez un ensemble d'options qui ne correspondent pas aux jeux Simple ou Réaliste, vous pouvez créer un jeu Personnalisé (ce choix s'ajoute alors à la liste).

Cochez **Ombrage** pour utiliser la méthode Gouraud pour le rendu des surfaces. Sinon, un ombrage plat est utilisé. L'ombrage plat établit une seule couleur et une seule brillance pour chaque polygone. Les bords sont visibles, les dégradés progressifs, mais les points d'éclairage ne sont pas possibles. Référez-vous au Guide Draw pour plus de détails sur l'ombrage.

Cochez **Bordures d'objet** pour tracer des lignes le long des côtés.

Cochez **Arrondi d'arêtes** pour adoucir les côtés des formes des boîtes. Dans certains cas, cette option n'est pas disponible.

**Éclairage**

Utilisez l'onglet **Éclairage** (Figure 15) pour déterminer les sources d'éclairage pour l'affichage 3D. Référez-vous au Guide Draw pour plus de détails sur l'éclairage.

Figure 14: Modifier l'apparence d’un diagramme 3D

Figure 15 : Paramétrer l'éclairage
Cliquez sur l’un des huit boutons pour allumer ou éteindre une source directe de lumière. Par défaut, la deuxième source de lumière est allumée. Les sources de lumière deux à huit sont normales et uniformes. La première source de lumière projette une lumière spéculaire avec des surbrillances.

Pour la source de lumière sélectionnée, vous pouvez alors choisir la couleur et l’intensité dans la liste juste en dessous des huit boutons. Les valeurs de brillance de toutes les lumières sont additionnées, utilisez donc des couleurs sombres quand vous activez plusieurs lumières.

Chaque source de lumière pointe toujours initialement au milieu de l’objet. Pour changer la position de la source de lumière, utilisez la petite prévisualisation de cet onglet. Elle a deux curseurs pour déterminer la position horizontale et verticale de la source de lumière sélectionnée.

Le bouton au coin de la petite prévisualisation permet de basculer le modèle d’éclairage interne entre une sphère et un cube.

Utilisez la liste Lumière ambiante pour définir la lumière ambiante qui brillera d’une intensité uniforme dans toutes les directions.

Faire tourner les diagrammes 3D de manière interactive

En plus de l’utilisation de l’onglet Perspective de la boîte de dialogue Affichage 3D, vous pouvez faire tourner les diagrammes 3D de manière interactive.

Sélectionnez la paroi du diagramme, puis placez le pointeur de la souris au-dessus d’une poignée de coin ou sur le symbole de rotation qui se trouve au milieu de la grille d’information du diagramme. Le curseur devient l’icône de rotation.

Appuyez et gardez appuyé le bouton gauche de la souris et faites glisser le coin dans la direction désirée. Un contour en pointillés du diagramme est visible pendant que vous faites glisser, pour vous aider à visualiser l’aperçu du résultat.

Formatter les éléments du diagramme

Selon le but de votre document, une présentation à l’écran ou un document imprimé pour une publication en noir et blanc par exemple, vous pouvez vouloir utiliser un contrôle plus détaillé des différents éléments du diagramme pour obtenir ce que vous voulez.

Pour formater un élément, cliquez sur l’élément que vous voulez changer, un des axes par exemple. L’élément sera mis en évidence avec des carrés verts. Faites alors un clic droit et choisissez une option dans le menu contextuel. Chaque élément de diagramme a sa propre sélection d’options. Dans les sections suivantes, nous allons voir certaines de ces options.

Formatter les grilles

Vous pouvez diviser les axes en faisant apparaître des grilles. Ceci permet une meilleure vision de votre diagramme, particulièrement s’il est de taille importante. La grille de l’axe Y est activée par défaut.

Il est possible de définir des grilles secondaires pour matérialiser deux niveaux de subdivisions des axes.

Le choix d’une commande de Format > Grille ouvre une boîte de dialogue (Figure 16) où vous pouvez spécifier les propriétés des lignes qui matérialisent la grille sélectionnée.
Formater les axes

Parfois vous avez besoin d'avoir une échelle spéciale pour l'un des axes de votre diagramme, ou vous avez besoin d'intervalles de grilles plus petits, ou vous voulez changer le formatage des étiquettes des axes. Après avoir mis en surbrillance l'axe que vous voulez changer, faites un clic droit et choisissez l'une des options du menu contextuel.

Le choix d'une commande de **Format > Axe** ouvre une boîte de dialogue (Figure 17). Les onglets et les champs valides dans cette boîte de dialogue dépendent de l'axe, du type de diagramme et s'il est 2D ou 3D.

**Onglet Échelle**

**Inverser la direction**

Définit le sens de progression des valeurs sur l'axe sélectionné. Par défaut, cette option est décochée. Dans ce cas de figure, pour les systèmes cartésiens de coordonnées, les valeurs les plus basses sont à gauche de l'axe X et en bas de l'axe Y ; pour les systèmes polaires de

---

*Figure 16 : Boîte de dialogue de formatage d'une grille*

*Figure 17 : Formater l'échelle des axes*
coordonnées, les valeurs de l’axe X (circulaire) évoluent dans le sens contraire aux aiguilles d’une montre et les valeurs les plus basses sont à l’intérieur de l’axe Y (radial). Cochez cette option pour obtenir l’effet inverse.

**Type**
Indique si l’axe est de type *Texte, Date* ou si Calc le détermine de façon *Automatique*. Si l’axe est de type *Date*, les données sont positionnées sur cet axe selon la valeur de leur date et non selon la séquence de leur ligne, comme illustré Figure 18. Elles peuvent donc ne plus être régulièrement espacées. Des options supplémentaires sont alors disponibles.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Locations</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>Canoës</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bateaux</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>01/01/13</td>
<td>12</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>10/01/13</td>
<td>9</td>
<td>31</td>
</tr>
<tr>
<td>5</td>
<td>25/01/13</td>
<td>14</td>
<td>27</td>
</tr>
<tr>
<td>6</td>
<td>15/01/13</td>
<td>17</td>
<td>28</td>
</tr>
<tr>
<td>7</td>
<td>01/02/13</td>
<td>13</td>
<td>19</td>
</tr>
<tr>
<td>8</td>
<td>10/02/13</td>
<td>8</td>
<td>27</td>
</tr>
</tbody>
</table>

*Figure 18 : Axe X de type Texte (à gauche) et de type Date (à droite)*

**Échelle logarithmique**
Cochez cette option pour utiliser une échelle logarithmique plutôt que l’échelle linéaire par défaut.

**Automatique**
Décochez cette option pour pouvoir spécifier une valeur particulière pour le champ correspondant.

**Minimum**
Définit la valeur minimum de l’axe.

**Maximum**
Définit la valeur maximum de l’axe.

**Intervalle principal**
Définit la valeur de l’intervalle entre deux lignes de la grille principale de l’axe. Si l’axe est de type *Date*, vous devez indiquer si cette valeur est exprimée en jours, en mois ou en année.
Nombre d'intervalles secondaires
Définit le nombre d’intervalles de la grille secondaire entre deux lignes de la grille principale. Si l’axe est de type *Date*, vous devez indiquer si cette valeur est exprimée en jours, en mois ou en année.

Résolution
Si l’axe est de type *Date*, définit si les valeurs de l’axe sélectionné sont des jours, des mois ou des années.

**Attention**
S'il existe plusieurs valeurs dans la résolution que vous avez choisie, seule la première sera retenue dans le graphe. Par exemple, dans l'exemple de la Figure 18, si vous choisissez une résolution en mois, seules les valeurs du 01/01/13 et du 01/02/13 figureront dans le diagramme.

**Onglet Positionnement**

<table>
<thead>
<tr>
<th>Ligne de l’axe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Croiser l’autre axe à</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Étiquettes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placer les étiquettes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Marques d’intervalles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principal : Intérieur</td>
</tr>
<tr>
<td>Secondaire : Intérieur</td>
</tr>
<tr>
<td>Placer les marques</td>
</tr>
</tbody>
</table>

*Figure 19 : Positionner les axes et leurs éléments*

**Croiser l’autre axe à**
Indique si l’axe sélectionné doit croiser l’autre axe au début de celui-ci, à la fin ou à une catégorie à préciser.

**Placer les étiquettes**
Indique s’il faut placer les étiquettes de l’axe sélectionné près de l’axe, près de l’axe (autre côté, c'est-à-dire à l’intérieur), au début du diagramme à l’extérieur ou à la fin du diagramme à l’extérieur. Dans ces deux derniers cas, vous pouvez indiquer où placer les marques.

**Marques d’intervalles – Principal**
Indique si les marques d’intervalle principal sont positionnées à l’intérieur de l’axe, à l’extérieur ou les deux.

**Marques d’intervalles – Secondaire**
Indique si les marques d’intervalle secondaire sont positionnées à l’intérieur de l’axe, à l’extérieur ou les deux.

**Placer les marques**
Si les étiquettes sont placées au début ou à la fin du diagramme à l’extérieur, indique s’il faut placer les marques aux étiquettes, à l’axe ou aux deux.
**Onglet Étiquette**

![Afficher l'étiquette]

<table>
<thead>
<tr>
<th>Ordre</th>
<th>Enchainements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mosaïque</td>
<td>Chevauchement</td>
</tr>
<tr>
<td>Transposer haut-bas</td>
<td>Saut</td>
</tr>
<tr>
<td>Transposer bas-haut</td>
<td></td>
</tr>
<tr>
<td>Automatique</td>
<td></td>
</tr>
</tbody>
</table>

**Orientation du texte**

![Empilé verticalement]

**Figure 20 : Formater les étiquettes des axes**

**Afficher l’étiquette**
Indique si les étiquettes de l'axe sélectionné sont affichées ou non.

**Ordre**
Permet de spécifier la disposition des étiquettes de l'axe sélectionné quand elles ne s'alignent pas parfaitement sur une seule ligne (par exemple, si les mots sont trop longs).

- **Mosaïque** : toutes les étiquettes sont au même niveau.
- **Transposer haut-bas** : une étiquette sur deux sera décalée vers l'extérieur, en commençant par la deuxième.
- **Transposer bas-haut** : une étiquette sur deux sera décalée vers l'extérieur, en commençant par la première.
- **Automatique** : Calc détermine automatiquement quelle disposition adopter.

**Chevauchement**
Indique que les étiquettes peuvent se chevaucher.

**Saut**
Permet à Calc d'insérer des sauts de ligne dans le texte des étiquettes pour une meilleure présentation.

**Orientation du texte**
Cliquez dans le panneau circulaire pour choisir l'angle de rotation des étiquettes, ou saisissez une valeur en degrés.

**Empilé verticalement**
Indique que le texte des étiquettes sera empilé verticalement.

**Onglets Ligne, Nombres, Police et Effets de caractère**
Les autres onglets de la boîte de dialogue, Ligne, Nombres, Police et Effets de caractère, sont relativement évidents. L'onglet Ligne regroupe les attributs de la ligne utilisée pour l'axe. L'onglet Nombres vous permet de déterminer les attributs de style de nombres utilisés. Police et Effets de caractère vous permettent de formater, entre autres, le type, la taille, la couleur et le style de police.
Étiquettes d’axes hiérarchiques

Les multiples colonnes de catégories sont affichées de manière hiérarchique sur les axes comme indiqué. Pour l’obtenir automatiquement quand vous créez un diagramme, assurez-vous que toutes les premières colonnes (ou lignes) contiennent du texte et pas seulement des nombres. Vous pouvez également choisir de déterminer les plages pour les catégories dans plusieurs colonnes dans l’onglet Séries de données de l’Assistant ou de la boîte de dialogue Plage de données.

<table>
<thead>
<tr>
<th>2009</th>
<th>Q1</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q2</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>4</td>
</tr>
<tr>
<td>2010</td>
<td>Q1</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Q2</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Q3</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Q4</td>
<td>11</td>
</tr>
</tbody>
</table>

Choisir et formater les symboles

Pour les diagrammes ligne et XY, les symboles représentant les points peuvent être modifiés en forme et en couleur à travers la boîte de dialogue des propriétés de l’objet. Sélectionnez la série de données que vous voulez changer, faites un clic droit et choisissez Formater les séries de données dans le menu contextuel.

Figure 21 : Sélection des symboles

Formatter les éléments du diagramme 26
Dans l'onglet Ligne de la boîte de dialogue Séries de données, dans la section Icône, choisissez dans la liste déroulante Sélectionner > Symboles. Ici vous pouvez choisir : aucun symbole, un symbole dans une sélection prédéfinie, une plus grande variété dans la Gallery, ou si vous avez des images que vous voulez utiliser, vous pouvez les insérer en utilisant Sélectionner > À partir d'un fichier.

**Ajouter des objets dessinés aux diagrammes**

Comme pour les autres composants LibreOffice, vous pouvez utiliser la barre d'outils de dessin pour ajouter des formes simples comme des lignes, des rectangles, des objets textes, ou des formes plus complexes comme des symboles ou des formes flèches. Utilisez ces formes supplémentaires pour ajouter des notes d'explication à votre diagramme, par exemple.

Pour formater des objets dessinés, faites un clic droit et choisissez une commande dans le menu contextuel.

---

**Redimensionner et déplacer le diagramme**

Vous pouvez redimensionner ou déplacer tous les éléments d'un diagramme à la fois, de deux manières : interactive avec la souris ou en utilisant la boîte de dialogue Position et taille. Vous pouvez combiner les deux méthodes : interactive pour les changements faciles et rapides, puis la boîte de dialogue pour une dimension et une position précises.

**Utiliser la souris**

Pour redimensionner un diagramme de manière interactive :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement apparaissent autour du diagramme.
2) Pour augmenter ou diminuer la taille du diagramme, cliquez et faites glisser l'un des marqueurs. Pour conserver le ratio entre hauteur et largeur, maintenez la touche Maj appuyée pendant cette opération.

Pour déplacer un diagramme de manière interactive :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement apparaissent autour du diagramme.
2) Déplacez le pointeur de la souris au-dessus du diagramme. Quand il se change en icône de déplacement ⬇️, cliquez et faites glisser jusqu'à sa nouvelle position.
3) Relâchez le bouton de la souris quand l'élément est dans la position voulue.
Utiliser la boîte de dialogue Position et taille

Pour redimensionner ou déplacer un diagramme en utilisant la boîte de dialogue Position et taille :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement apparaissent autour du diagramme.
2) Faites un clic droit et choisissez Position et taille dans le menu contextuel.
3) Faites vos choix dans cette boîte de dialogue.

La position est définie par des coordonnées X et Y relatives à un point fixe (le point de base), ordinairement situé en haut et à gauche du document. Vous pouvez temporairement changer ce point de base pour rendre le positionnement ou le dimensionnement plus simple (cliquez sur l'endroit à l'emplacement du point de base dans l'une des deux fenêtres de sélection du côté droit de la boîte de dialogue, en haut pour le positionnement et en bas pour le dimensionnement).

Figure 22 : Définir la position et la taille d'un objet

Les positions possibles du point de base correspondent aux poignées du cadre de sélection, plus un point central. Le changement de position dure tant que la boîte de dialogue est ouverte ; quand vous fermez cette boîte, Calc réinitialise le point de base dans sa position standard.

Astuce

L'option Proportionnel est très utile. Cochez-la pour conserver le ratio entre largeur et hauteur quand vous changez la taille d'un objet.

La taille, la position, ou les deux peuvent être protégées pour qu'elles ne puissent être modifiées accidentellement. Cochez les options correspondantes.

Astuce

Si vous ne pouvez pas déplacer un objet, vérifiez si sa position n'est pas protégée.
Exporter un diagramme en tant qu'image

Vous pouvez exporter un diagramme pour le transformer en image. Pour ceci, sélectionnez le diagramme, afin que les poignées vertes de dimensionnement apparaissent. Puis faites un clic droit et choisissez Exporter comme image dans le menu contextuel. Dans la boîte de dialogue Export d'image, choisissez un emplacement et saisissez le nom du fichier image. Plusieurs formats d'image sont disponibles dans la liste déroulante Type de fichier.

Format OpenDocument ODC

Parmi les formats OpenDocument, il existe un format ODC permettant de définir le stockage des diagrammes, de la même façon qu'il existe un format ODS pour définir le stockage des classeurs. LibreOffice permet désormais de manipuler de tels fichiers.

Attention

Le format OpenDocument ODC n'a rien à voir avec le format Microsoft ODC qui permet de stocker des connexions de données. Organisez vos fichiers de manière à éviter toute confusion si vous êtes amenés à manipuler ces deux formats.

Si vous avez défini un diagramme que vous voulez réutiliser, et particulièrement si vous avez passé beaucoup de temps à le formater, il peut être intéressant de l'enregistrer en tant que fichier individuel au format ODC. Vous pourrez ainsi le réutiliser facilement dans de nombreux autres classeurs, sans avoir à le recommencer ex nihilo.

Enregistrer un diagramme au format ODC

Pour enregistrer un diagramme au format ODC, vous devez tout d'abord l'éditer en le double-cliquant. Le diagramme devrait être maintenant entouré par une bordure grise. Choisissez alors Fichier > Enregistrer sous depuis la barre de menus. La boîte de dialogue Enregistrer sous s'ouvre, et le type de fichier Diagramme ODF (.odc) est sélectionné. Spécifiez le nom du fichier et son emplacement, et cliquez sur Enregistrer.

Ouvrir un diagramme au format ODC

Vous pouvez ouvrir un fichier au format ODC en choisissant Fichier > Ouvrir depuis la barre de menus et en sélectionnant le fichier désiré, puis en cliquant sur Ouvrir. Une fenêtre LibreOffice Chart s'ouvre, vous permettant de visualiser le diagramme. Vous pouvez effectuer un certain nombre de formatages sur votre diagramme, mais soyez conscient que vous ne pourrez pas les enregistrer ici.

Insérer un diagramme ODC dans un classeur

Pour insérer un diagramme enregistré au format ODC dans votre classeur, choisissez Insertion > Objet > Diagramme à partir d'un fichier depuis la barre de menus. Dans la boîte de dialogue Ouvrir, sélectionnez le fichier contenant le diagramme et cliquez sur Ouvrir. Il peut être nécessaire de redéfinir la plage de données sur laquelle ce diagramme s'appuie.

Galerie des types de diagramme

Il est important de garder à l'esprit que si vos données peuvent être présentées par plusieurs diagrammes différents, le message que vous voulez délivrer va déterminer le diagramme que vous allez finalement utiliser. Les sections suivantes présentent des exemples de types de diagramme que Calc peut fournir, avec quelques améliorations possibles et des notes sur les buts que vous pouvez avoir pour chaque type. Pour plus de détails, voir l'index de l'Aide.

Galerie des types de diagramme
Colonne

Les diagrammes de type *Colonne* (Figure 3) sont fréquemment utilisés pour des données qui montrent des tendances dans la durée. Ils sont indiqués pour des diagrammes qui ont relativement peu de points de données. (Pour de plus grandes séries dans la durée, une ligne est préférable.) C'est le type de diagramme par défaut, et c'est l'un des diagrammes les plus utiles et les plus faciles à comprendre.

Les diagrammes de type *Colonne* comprennent des barres verticales dont la hauteur est proportionnelle à leur valeur. L'axe X affiche les catégories et l'axe Y leurs valeurs.

Le sous-type *Normal* affiche toutes les valeurs de données appartenant à des catégories proches l'une de l'autre. L'attention est portée sur chaque valeur absolue individuelle comparée aux autres valeurs.

Le sous-type *Empilé* affiche les valeurs des données de chaque catégorie les unes au-dessus des autres. L'attention est portée sur la valeur totale de chaque catégorie et la part individuelle de chaque valeur dans sa catégorie.

Le sous-type *Pourcentage empilé* affiche le pourcentage relatif de chaque valeur de données par rapport au total de sa catégorie. L'attention est portée sur la part relative de chaque valeur dans le total de sa catégorie.

Si vous choisissez l'affichage 3D, vous pouvez accéder au sous-type *Profond* qui affiche les valeurs des données de chaque catégorie sur l'axe Z. Vous pouvez également choisir, pour représenter la colonne en 3D entre les formes Boîte, Cylindre, Cône et Pyramide.

Barre

Les diagrammes de type *Barre* sont semblables aux diagrammes de type *Colonne*, sauf que les catégories sont affichées sur l'axe Y et leurs valeurs sur l'axe X. Les sous-types de diagrammes sont les mêmes : voyez "Colonne" page 30 pour leur explication détaillée.

Les diagrammes de type *Barre* sont excellents pour fournir un impact visuel immédiat d'une comparaison de données dans les cas où le temps n'est pas un facteur important, par exemple pour comparer la popularité de quelques produits d'un lieu de vente donné.

Figure 23 : Trois graphiques de type Barre

- Le premier diagramme est réalisé très simplement en utilisant l'assistant, en modifiant les axes X et Y et en utilisant **Insertion > Courbes de valeur moyenne**.
- Le deuxième diagramme comprend l'option 3D de l'assistant avec une bordure simple et une rotation du diagramme 3D.

**Galerie des types de diagramme** 30
Le troisième diagramme illustre comment se passer de légende en insérant les valeurs et des étiquettes sur l'axe pour afficher le nom des produits. Les couleurs ont été également transformées en hachures.

**Secteur**

Les diagrammes de type *Secteur* affichent les catégories comme des secteurs circulaires d'un cercle total. La longueur de chaque arc et la surface de chaque secteur sont proportionnelles à leur valeur.

Le sous-type *Normal* affiche les secteurs sous forme de zones colorées d'un cercle total, pour une seule colonne de données. Vous pouvez cliquer et glisser sur n'importe quel secteur pour le séparer du cercle total ou pour le joindre à nouveau.

Le sous-type *Diagramme en secteur éclaté* affiche les secteurs déjà séparés les uns des autres. Vous pouvez cliquer et glisser sur n'importe quel secteur pour le déplacer le long d'une ligne radiale à partir du centre.

Le sous-type *Tore* peut afficher des valeurs de données multiples. Chaque colonne de données est affichée en forme de tore avec un trou à l'intérieur, où la colonne de données suivante peut être affichée. Vous pouvez cliquer et glisser sur un secteur extérieur pour le déplacer le long d'une ligne radiale à partir du centre du tore.

Le sous-type *Diagramme Tore éclaté* affiche les secteurs extérieurs déjà séparés du reste du tore. Vous pouvez cliquer et glisser sur un secteur extérieur pour le déplacer le long d'une ligne radiale à partir du centre du tore.

Les diagrammes de type *Secteur* sont excellents quand vous avez besoin de comparer des proportions. Par exemple, un diagramme de type secteur est idéal pour montrer une comparaison des dépenses d'établissements, ce qu'un établissement a dépensé en différents produits ou ce que différents établissements ont dépensé. Ces diagrammes fonctionnent mieux avec un petit nombre de valeurs, pas plus d'une demi-douzaine. L'impact visuel diminue avec plus de valeurs.

Même si l'Assistant de diagramme devine les séries que vous voulez inclure dans vos secteurs, vous pouvez avoir besoin de l'ajuster dans la page *Plage de données* de l'Assistant ou en utilisant la boîte de dialogue de *Format > Plages de données > Séries de données*.

Vous pouvez faire des choses intéressantes avec des secteurs, plus particulièrement avec un diagramme 3D. Vous pouvez l'incliner, lui donner des ombres et plus généralement en faire pratiquement une œuvre d'art. Ne l'encombrez cependant pas trop afin de ne pas égarer votre message, et faites attention à ce que l'inclinaison ne distorde pas la proportion des secteurs.

Vous pouvez choisir l'option dans L'Assistant de diagramme pour éclater les secteurs, mais c'est une option tout ou rien. Si votre but est de mettre en évidence un secteur de l'ensemble, vous pouvez le séparer en le sélectionnant soigneusement une fois que vous avez terminé l'Assistant de diagramme, et en le faisant glisser en dehors du groupe. Quand vous faites ceci, il est peut-être nécessaire d'agrandir à nouveau le diagramme pour retrouver la taille d'origine des secteurs.

Les effets obtenus Figure 24 sont expliqués ci-dessous.

- Le premier exemple est un secteur 2D avec un secteur de l'ensemble éclaté. Pour produire ce type de diagramme, choisissez tout d'abord *Insertion > Légende* et décochez *Afficher la légende*. Choisissez *Insertion > Étiquettes de données* et cochez *Afficher la valeur sous forme de nombre* et *Afficher la catégorie*. Puis sélectionnez soigneusement le secteur que vous voulez mettre en évidence en plaçant le curseur au-dessus, cliquez (le secteur aura des carrés verts pour l'indiquer), et faites-le alors glisser hors de l'ensemble des autres secteurs. La taille de secteurs va diminuer, vous devrez peut-être alors sélectionner le diagramme et faire glisser un de ses coins pour augmenter sa taille.

- Le deuxième exemple est un diagramme secteur 3D avec un schéma réaliste et un éclairage. À partir d'un diagramme secteur 2D terminé, passez le en 3D et choisissez
Format > Affichage 3D > Éclairage où vous pouvez modifier la direction de l'éclairage, la couleur de la lumière ambiante et la profondeur de l'ombre. Vous pouvez également ajuster l'angle 3D du disque dans l'onglet Perspective de cette boîte de dialogue.

Le diagramme se met à jour dès que vous effectuez les modifications, vous pouvez donc voir immédiatement leurs effets.

Si vous voulez séparer l'un des secteurs, cliquez soigneusement sur celui-ci ; vous devriez voir un cadre en pointillés pour le mettre en évidence. Faites-le glisser avec la souris, puis, si nécessaire, augmentez la taille du diagramme.

**Figure 24 : Diagrammes de type Secteur**

- Le troisième exemple est un diagramme secteur 3D avec différents effets de remplissage pour chaque secteur du disque. Choisissez Insertion > Étiquettes de données et cochez Afficher la valeur sous forme de pourcentage. Sélectionnez soigneusement chacun des secteurs pour que leur cadre en pointillés apparaisse, puis faites un clic droit et choisissez Formater le point de données pour obtenir la boîte de dialogue des propriétés de l'objet. Choisissez l'onglet Remplissage. Pour un des secteurs, nous avons choisi un effet bitmap, pour un autre nous avons sélectionné un dégradé et pour le troisième, nous avons utilisé l'onglet Transparence et ajusté la transparence à 50 %.

Les diagrammes de sous-types Tore permettent de représenter des colonnes de données multiples. Pour plus de possibilités, cochez 3D.

**Figure 25 : Exemples de diagrammes de sous-type Tore**
Zone

Les diagrammes de type Zone comprennent des zones de données. L’axe X affiche les catégories et l’axe Y leurs valeurs, les valeurs de chaque colonne de données étant reliées par une ligne. La zone entre deux lignes est remplie par une couleur.

Le sous-type Normal affiche toutes les valeurs comme des valeurs absolues. Il trace d'abord la zone de la dernière colonne de la plage de données, puis la précédente, et ainsi de suite jusqu’à la première colonne de données.

Le sous-type Empilé affiche les valeurs des données de chaque catégorie les unes au-dessus des autres. Cependant, les valeurs ne sont plus des valeurs absolues, excepté pour la dernière colonne dessinée en bas des zones empilées.

Le sous-type Pourcentage empilé affiche les valeurs des données de chaque catégorie les unes au-dessus des autres et les mesure en pourcentage.

Un diagramme de type Zone est une version d'un graphique ligne ou colonne. Il peut être utile quand vous souhaitez mettre en évidence le volume des changements. Les diagrammes Zone ont un plus grand impact visuel qu'un diagramme Ligne, mais les données que vous représentez peuvent influer sur le choix du type.

Comme montré Figure 26, un diagramme de type zone est parfois délicat à utiliser. Ce peut être une bonne raison d'utiliser les valeurs de transparence dans un diagramme zone. Après avoir paramétré le diagramme de base dans l’Assistant de diagramme, effectuez les manipulations suivantes :

- Faites un clic droit sur l'axe Y et choisissez Supprimer la grille principale. Comme les données se recouvrent, certaines d’entre elles sont perdues derrière la première série de données. Ce qui n'est pas souhaitable. Le deuxième diagramme est meilleur.


- Pour créer la troisième variante, après avoir fait les étapes ci-dessus, faites un clic droit et choisissez Type de diagramme. Cochez 3D et sélectionnez Réaliste dans la liste déroulante. Nous avons également fait pivoter le diagramme et donné à la paroi du diagramme l'image du ciel. Les étiquettes de l'axe Z rendent la légende superflue. Mais, bien que le diagramme soit visuellement plus attractif, il est plus difficile de voir la signification des données.

Figure 26 : Diagrammes de type Zone : le bon et le moins bon

Galerie des types de diagramme
Les sous-types Empilé et Pourcentage empilé sont d'autres façons de représenter les mêmes séries de données.

**Figure 27 : Diagrammes de sous-types Empilé et Pourcentage empilé**

Le premier fait ce qu'il dit : chaque nombre de chaque série est ajouté aux autres ; ainsi, c'est le volume total qui est montré et non une comparaison des données. Le diagramme Pourcentage empilé montre chaque valeur dans les séries comme une partie d'un tout. Dans cet exemple, les trois valeurs sont additionnées et le résultat représente 100 % pour chaque mois. Les valeurs individuelles sont un pourcentage de cela. Beaucoup de diagrammes ont des variantes qui ont cette option.

**Ligne**

Un diagramme de type Ligne est une série dans le temps avec une progression. Il est idéal pour les données brutes, et utile pour les diagrammes avec beaucoup de données qui affichent des tendances ou des évolutions dans le temps et où vous voulez mettre en évidence la continuité. Dans les diagrammes de type ligne, l'axe X est idéal pour être la série de données temps.

Les diagrammes de type Ligne comprennent des points dont la hauteur est proportionnelle à leur valeur. L'axe X affiche les catégories et l'axe Y leurs valeurs, les valeurs de chaque colonne de données pouvant être reliées par une ligne.

Le sous-type Points seuls n'affiche que les points, sans tracer de ligne.

Le sous-type Points et lignes affiche les points et relie par une ligne les valeurs de chaque colonne de données.

Le sous-type Lignes seules n'affiche que les lignes, sans tracer de points.

Le sous-type Lignes 3D affiche les points et relie par une ligne en 3D les valeurs de chaque colonne de données.

Les lignes en 3D sont souvent confuses pour le lecteur, et il est généralement préférable d'utiliser une ligne plus épaisse.

Cochez l'option Séries empilées pour afficher les valeurs cumulatives des colonnes de données de chaque catégorie. Choisissez En haut pour afficher les valeurs cumulées ou Pourcentage pour afficher les pourcentages par rapport au total.
Vous disposez de plusieurs types de ligne :

- **Droit** : les lignes sont des droites directes entre les points.
- **Adoucir** : les lignes sont des courbes entre les points.
- **Escalier** : les lignes sont des droites horizontales et verticales entre les points.

Pour ces deux derniers types de ligne, vous pouvez cliquer sur **Propriétés** pour accéder à des paramètres supplémentaires.

**Figure 28 : Diagrammes de type ligne**

**Dispersion ou XY**

Un diagramme de type XY est semblable à un diagramme de type Ligne, sauf que figurent sur l'axe X des valeurs et non des catégories. Il représente une ou plusieurs séries de données consistant en une liste de valeurs X et une liste de valeurs Y. Chaque paire de valeurs est affichée comme un point dans un système de coordonnées. Le nom de chaque série de données est associé avec les valeurs et affiché dans la légende.

Si la plage de données correspondant à l'axe X contient des valeurs non numériques, celles-ci sont remplacées par le numéro de séquence correspondant.

Les diagrammes de type XY sont utiles pour mettre en évidence ou vérifier l'existence de corrélation, d'une relation entre ces valeurs. Ils sont indiqués pour représenter le graphique d'une fonction ou toutes autres données qui font correspondre deux séries de données numériques.

Les sous-types de diagramme et les types de ligne sont identiques aux diagrammes de type Ligne : voir "Ligne" page 34.

L'exemple suivant Figure 29 montre un usage moins courant où l'on a représenté la plage A2:I5 avec les options **Première colonne comme étiquette** et **Plage de données > Séries de données en ligne**. La première ligne de données contient les valeurs pour le Yen auxquelles sont comparées les trois autres devises. Le Yen JPY n'apparaît donc pas en tant que tel ; il est simplement utilisé comme une série de constantes avec lesquelles les autres séries de données sont comparées.
Figure 29 : Une période particulièrement volatile pour le marché mondial des devises

Bulles

Un diagramme de type Bulle est une variante du diagramme dispersion dans lequel les points de données sont remplacés par des bulles. Il montre les relations entre trois variables en deux dimensions. Deux variables sont utilisées pour la position sur les axes X et Y, tandis que la troisième est indiquée par la taille relative de chaque bulle. Une ou plusieurs séries de données peuvent être comprises dans un seul diagramme.

Si la série de données de l'axe X est constituée de textes, c'est un numéro d'ordre qui figurera comme étiquette de cet axe. Dans le cas contraire, les données de la série sont utilisées pour le positionnement selon l'axe X, ce qui peut conduire à des bulles irrégulièrement espacées, comme Figure 30.

Les diagrammes bulle sont souvent utilisés pour présenter des données financières. Le champ Plages de données a une entrée pour définir la plage de données des bulles et de leur taille.
**Toile**

Un diagramme de type *Toile* est similaire à un diagramme polaire ou radar. Il est utile pour comparer des données qui ne sont pas dans une série de temps, mais dans des circonstances différentes, comme des variables dans une expérience scientifique ou des directions. Les pôles d'un diagramme *Toile* sont l'équivalent de l'axe Y des autres diagrammes. Généralement, le mieux est d'avoir entre trois et huit catégories ; si vous avez plus de catégories, ce type de diagramme devient confus. Les valeurs avant et après peuvent être tracées sur le même diagramme, ou les résultats prévus et réalisés, pour que les différences puissent être comparées.

Les diagrammes de type *Toile* comprennent des points dont l'éloignement du centre est proportionnel à leur valeur. L'axe circulaire affiche les catégories et l'axe radial leurs valeurs, les valeurs de chaque colonne de données pouvant être reliées par une ligne.

Le sous-type *Points seuls* n'affiche que les points, sans tracer de ligne.

Le sous-type *Points et lignes* affiche les points et relie par une ligne les valeurs de chaque colonne de données.

Le sous-type *Lignes seules* n'affiche que les lignes, sans tracer de points.

Le sous-type *Plein* affiche les points, relie par une ligne les valeurs de chaque colonne de données et remplit la zone entre deux lignes par une couleur. Une transparence partielle est souvent préférable pour montrer toutes les séries en une fois (Figure 32).

Cochez l'option *Séries empilées* pour afficher les valeurs cumulatives des colonnes de données de chaque catégorie. Choisissez *En haut* pour afficher les valeurs cumulées ou *Pourcentage* pour afficher les pourcentages par rapport au total.

La Figure 31 montre deux types de diagrammes *Toile* :

- (Gauche) : Diagramme toile simple sans grilles ni lignes, seulement des points.
- (Droite) : Diagramme toile avec des lignes, des points et une grille. Les couleurs des axes et les étiquettes ont été modifiées. La couleur de la zone de diagramme a été changée avec un dégradé. Les points de ce graphique ont été changés en sphères 3D fantaisie.

---

**Galerie des types de diagramme**

37
Figure 31 : Deux diagrammes de type Toile

Figure 32 : Diagramme toile ou radar avec remplissage
Cours

Un diagramme de type *Cours* est un graphique en colonnes spécialisé pour la bourse et les actions. Dans ce type de diagramme, l’axe X représente une série temps. Les données nécessaires pour ces diagrammes sont très particulières, avec des séries pour le volume de transactions, le prix à l’ouverture, le prix à la fermeture et les prix maximum et minimum. Choisissez parmi les quatre types proposés en fonction des données disponibles :

- **Type 1** : Ce diagramme permet de montrer l’amplitude de la variation du cours par une ligne verticale entre la valeur la plus basse et la valeur la plus haute. De plus, la valeur de clôture est matérialisée par une ligne horizontale. Les plages de données nécessaires sont Valeurs basses, Valeurs hautes et Valeurs de clôture.

- **Type 2** : Ce diagramme permet de montrer l’amplitude de la variation du cours par une ligne verticale entre la valeur la plus basse et la valeur la plus haute. De plus, un rectangle délimité par les valeurs d’ouverture et de clôture recouvre cette ligne verticale. La couleur du rectangle varie selon le fait que la valeur de clôture soit supérieure à la valeur d’ouverture ou non. Les plages de données nécessaires sont Valeurs d’ouverture, Valeurs basses, Valeurs hautes et Valeurs de clôture.

- **Type 3** : Ce diagramme est identique au type 1, en ajoutant la représentation du volume de transactions sous forme d’histogramme. Les plages de données nécessaires sont Volume, Valeurs basses, Valeurs hautes et Valeurs de clôture.

- **Type 4** : Ce diagramme est identique au type 2, en ajoutant la représentation du volume de transactions sous forme d’histogramme. Les plages de données nécessaires sont Volume, Valeurs d’ouverture, Valeurs basses, Valeurs hautes et Valeurs de clôture.

Pour les types 3 et 4, un axe secondaire est ajouté pour représenter les valeurs, l’axe principal étant dévolu au volume.
La définition précise des plages de données est importante pour obtenir un diagramme significatif. Vous devez préciser quelle série représente le prix à l'ouverture, le prix à la fermeture, les prix maximum et minimum de l'action, et ainsi de suite, comme Figure 34. Si vous saisissez une plage incorrecte, Calc l'affiche sur fond rouge.

Figure 34 : Plages de données du diagramme Cours 4

**Colonne et ligne**

Un diagramme de type **Colonne et ligne** est une combinaison de deux autres types de diagrammes. Il est utile pour combiner deux séries de données distinctes, mais liées comme les coûts de production dans le temps (colonne) avec l'évolution des marges (ligne).

Vous pouvez choisir le nombre de colonnes et de lignes dans l'Assistant de diagramme. Vous pourriez ainsi avoir deux colonnes et deux lignes pour représenter deux lignes de produits, avec pour chacune les coûts et la marge.

Le diagramme de la Figure 35 comporte les coûts de production et la marge pour deux produits, pendant une période de temps (le 1er semestre). Pour créer ce diagramme, sélectionnez tout d'abord le tableau et démarrez l'Assistant de diagramme. Choisissez le type de diagramme Colonne et ligne avec deux lignes et les séries de données en lignes. Puis donnez un titre pour mettre en évidence l'aspect que vous voulez montrer. Les lignes ont des couleurs différentes à cette étape et ne reflètent pas le fait que c'est le même produit. Une fois terminé avec l'Assistant de diagramme, sélectionnez le diagramme, cliquez sur la ligne, faites un clic droit et choisissez **Formatter les séries de données**.

Dans cet onglet, il y a plusieurs choses à changer : les couleurs doivent correspondre. Ainsi, le coût de fabrication et la marge du produit P1 sont bleus et les valeurs du produit P2 sont rouges. Si les lignes ne sont pas assez visibles, augmentez leur épaisseur à 0,05.
Pour l'arrière-plan, sélectionnez la paroi du diagramme, faites un clic droit et choisissez Formater la paroi. Dans l'onglet Remplissage, choisissez Dégradé dans la liste déroulante. Choisissez également un des dégradés prédéfinis et rendez-le plus léger en allant dans l'onglet Transparence et afin de rendre le dégradé transparent à 50 %.

Pour rendre le diagramme plus propre sans la grille, allez à Insertion > Grilles et décochez l'axe X.